
Release Notes 
Hyperwire 1.0 Trial Version

These Release Notes include information about the trial version of Hyperwire 1.0 and its installation 
programs. This document contains information not covered in the Online Reference. 

For Product Support information and the latest information about Hyperwire and publishing Hyperwire 
titles on a server, see the Kinetix Web site at www.ktx.com/hyperwire.

Three major subjects are covered in this document:

I. Setup 
II. Where to Start 
III. Information About Hyperwire Version 1.0

I. Setup

Your system must meet the following minimum system requirements in order to install and run Hyperwire. 

Windows 95 or Windows NT (3.51 or 4.0) installed 
32 MB of RAM 
up to 110 MB of disk space for setup
45 MB of disk space after installing all options

We recommend that you use a computer with 90 MHz Pentium or faster CPU. If you intend to build 3D 
titles, you may want to use an even faster machine with more memory.

The following are the installation files you will find on the Hyperwire 1.0 CD-ROM: HWSETUP.EXE, 
HW3D.EXE, HWWHIP.EXE, and HWRT.EXE.

HWSETUP.EXE
This is the main installation program for Hyperwire. Start the install by double-clicking this file from 
Windows. There are four different components that can be installed:

Base Hyperwire
3D Support
Whip Support
Hyperwire Samples

Choose the Typical option to install all Hyperwire components. Use the Compact option if you only want 
the Base Hyperwire product. Choose the Custom option to select which component you want installed. The 
3D portion of Hyperwire requires you to install a Microsoft Reality Lab component along with Hyperwire. 
The Hyperwire installation program will run the install for this component if it does not already exist on 
your system. When the Reality Lab install starts, you will be given the choice of installing either the 
‘Software Driver’ or the ‘Eagle Driver’. Choose the ‘Software Driver’ option. 

Hyperwire Runtime Installs
Hyperwire includes three runtime install programs to help you run Java applets from the Web and Java 
applications from your local computer. They can be found in the \Client folder on your Hyperwire CD-
ROM. These runtime install programs can also be found and downloaded from the Kinetix Web site at 
www.ktx.com.

Who Needs the Hyperwire Runtime Install Programs?



Not everyone will need a Hyperwire runtime to run Hyperwire titles. The runtimes are typically for end-
users who do not have the Hyperwire authoring system and want to view a Hyperwire title under the 
following circumstances.

- If a Hyperwire title uses Hyperwire’s 3D features, the 3D runtime will need to be installed on the local 
system where the title is to be viewed.

- If a Hyperwire title uses Hyperwire’s Whip! feature, the Whip! runtime will need to be installed on the 
local system where the title is to be viewed.

- If the end-user is running Netscape Navigator, you can still run a Hyperwire title, but the title will run 
faster if you install the Hyperwire Java runtime classes on your system. Once the runtime classes are 
installed on the local system, the browser will not have to go through the process of transferring the 
required class files from the source to the local system.

- It is not necessary to use any of the runtime installs with the Hyperwire authoring system. These same 
files are included in the Hyperwire Authoring System install process.

The three runtime installation programs are: HW3D.EXE, HWWHIP.EXE, and HWRT.EXE.

HW3D.EXE -- The 3D Runtime
This install provides the client side support for 3D titles generated by Hyperwire. Anyone running a 3D 
Hyperwire title, whether downloaded from the Web or distributed on CD-ROM, will have to run this install 
before running the title. 

The 3D portion of Hyperwire requires you to install a Microsoft's Reality Lab component along with 
Hyperwire. The installation program will run the install for this component if it does not already exist on 
your system. When the Reality Lab install starts, you will be given the choice of installing either the 
‘Software Driver’ or the ‘Eagle Driver.’ Choose the ‘Software Driver’ option. 

This install is freely distributable. It can be posted on the Web or you may put it on a CD-ROM with your 
Hyperwire title.

Hyperwire's 3D system works only on Windows 95, NT 3.51 and NT 4.0. This 3D component will run 
under Netscape Navigator 3.x and Microsoft Internet Explorer 3.x. Netscape Navigator 4.0 is not 
supported.

For Netscape Navigator users, different versions of the file NW3DGLUE.DLL are installed, depending on 
the version of Navigator currently installed on your system. There is a separate version of this .DLL file for 
Netscape 3.0 and 3.01. The installation program detects what version of Navigator you have and installs the
corresponding .DLL to Netscape’s \Program\Java\Bin folder. It is important to know this in case you 
happen to update or reinstall Navigator after the 3D runtime has been installed. In this case, you may need 
to reinstall the Hyperwire 3D runtime. 

HWWHIP.EXE -- The Whip! Runtime
Whip! is a technology for viewing 2D drawings exported as .DWF files by AutoCAD and other software 
products. The .DWF format is specially designed to compress information to make download over the Web 
more efficient. This install provides the client side support for titles which include .DWF files. Anyone 
running a Hyperwire title which displays .DWF files, whether downloaded from the web or distributed on 
CD, will have to run this install before running any titles.

This install is freely distributable. It can be posted on the Web or you may put it on a CD-ROM with your 
Hyperwire title.

Whip! is supported only on Windows 95 and NT 4.0. Whip! is not supported under Windows NT 3.51. Use 
Whip! with Netscape Navigator 3.x or Microsoft Internet Explorer 3.x.  Netscape Navigator 4.0 is not 



supported.

HWRT.EXE -- Hyperwire’s Java Runtime Classes
This installs Hyperwire's Java runtime classes on your computer. This install is provided to help 
Hyperwire-generated Java programs start up more quickly by pre-installing Hyperwire's classes on the local
machine. It is not necessary to have these classes installed in order to run your Java programs, Hyperwire's 
runtime classes will automatically download from the Web if needed.

This install is provided mainly for clients using Netscape Navigator. Microsoft’s Internet Explorer includes 
support for Cabinet files that will download and install the Hyperwire Run-time classes automatically.

Note: The 3D Runtime and Whip! Runtime installs also install Hyperwire’s Java runtime classes. It is not 
necessary to install HWRT.EXE if you have already installed the 3D or Whip!. 

CLASSPATH and PATH Environment Variables
Java uses the CLASSPATH environment variable to find the compiled Java code, or classes it needs to 
execute a Java program. When you install Hyperwire, the Classes folder in the Hyperwire installation 
folder is added to your CLASSPATH. If no CLASSPATH variable is defined, the installation program 
creates it. The Hyperwire classes are added to the CLASSPATH to make it possible for you to load Java 
applets, generated by Hyperwire, into Navigator or Internet Explorer. This variable does not need to be set 
in order to build and test a Hyperwire Java title within Hyperwire.

Hyperwire adds the Java/bin folder under the Hyperwire folder to your PATH variable.

The variables are set in the AUTOEXEC.BAT for Windows 95 and in the Environment Variables section of 
the System dialog under the Control Panel for Windows NT.

Using the Uninstall Feature 
The Hyperwire installation program has an Uninstall feature to help you remove the program from your 
system. There are a few issues to be aware of when using Uninstall. Uninstall does not remove any 
CLASSPATH or PATH variables that may have been written to your AUTOEXEC.BAT file. Any additions 
the Hyperwire installation makes to your AUTOEXEC.BAT must be deleted manually. Uninstall will not 
delete the contents of any directories that were created after the installation process was completed. For this
reason, some directories and files may remain in the Hyperwire directory after running Uninstall.

II. Where to Start 

Introductory Title
The first time you start Hyperwire, you have the option to view a multimedia title that shows a quick 
overview of how to build Java programs with Hyperwire. You can also select "Introductory Title" from the 
Help menu in Hyperwire.

Tutorials
You start the tutorials by selecting "Tutorial Exercises" from the Help menu in Hyperwire. You need to 
have an HTML browser installed on your system to view the tutorials.

Online Reference
In-depth information about Hyperwire is available online. Select "Reference" from the Help menu in 
Hyperwire to open the Hyperwire Online Reference. 

You can also open the Online Reference by using F1 with the menu bar, by clicking the Help button on 
many of Hyperwire's dialogs, or by clicking the “?” button from the toolbar, then selecting the feature of 
your choice.



No printed documentation is provided with the product.

III. Information About Hyperwire Version 1.0 

Hyperwire is a tool for assembling multimedia Java titles. Because Hyperwire is an assembly tool, it is 
dependent on other software to create media for the title.  Other software is also required to play the title. 
You'll find many of the same general process issues required to build and deploy HTML documents are also
issues when building and deploying Java titles. The look and performance can vary depending on the 
Browser used, the connection to the Web, the computer used, and the content of your title.

We have tested extensively with a wide variety of different configurations. 

The following is information you should know about Hyperwire Version 1.0.

Long File Names 
Java makes use of long file names. Therefore, you cannot copy the Hyperwire files to a network that only 
understands the standard DOS filename of eight characters with a three-character extension. 

Java Is Case-Sensitive 
Java is case-sensitive, so when you name or refer to Java files, be sure to maintain a consistent use of 
mixed case file names. Java class file names also require the first character to be uppercase. If you use 
Export As Java to export a class file name that begins in lowercase, your application will not load. 

Deploying Hyperwire Titles on a Web Server 
See the Online Reference about placing Hyperwire titles on a Web server. Also, see the Tutorials about 
publishing Hyperwire titles. In general using the "Publish Title" command will put everything you need in a
single folder for delivery to the web.

If you are deploying titles from a UNIX-based server, you will certainly encounter problems related to the 
case of file names referenced in your title. Windows is not case-sensitive, while UNIX usually is. There are 
a number of different file operations that can change the case of your title under Windows. Many FTP 
programs also change the case of file names. It’s a good idea to check the case of all external files 
referenced by an applet after moving it to a UNIX server. Hyperwire outputs a summary that lists all 
external files referenced when Applets are published. You can use the information in the summary to 
compare with the files on your Web server. 

It's a good idea to clear out your browser cache before testing titles delivered from the Web.

Java Error Messages
Knowing where error messages are posted while testing a Java Applet can be confusing. Messages are 
posted to different places depending on the viewer you are using.

If you run your titles in JavaSoft’s Applet Viewer, all messages are posted to the Java Console window. 
This window can be opened from the Show/Hide Java Console command in the Window menu in 
Hyperwire.

If you run your titles in Netscape Navigator, compile and startup messages are posted to Hyperwire’s Java 
Console window. Applet runtime errors are posted to Navigator’s Java Console window, which can be 
opened from a command under its Options menu.

If you run your titles in Internet Explorer, compile and startup messages are posted to Hyperwire’s Java 
Console window. Applet runtime errors are posted to javalog.txt file in your Windows Java folder. You’ll 
need to make sure you’ve enabled Java logging in the Advanced tab of the Options dialog in order to see 
these messages.



ISSET_SE Error
On rare occasions while installing under Windows NT two error messages will appear when the Hyperwire 
install has finished.  A message reads, “An error has occurred in your application”, followed by a second 
message which mentions a “General Protection Fault”.  This error does not have any effect on your 
Hyperwire install.  Select the Close button on each message to close them.  

Building Your Own Hyperwire Modules 
It is possible to build your own Java-based "plug-in" modules with Hyperwire. Several sample plug-in 
modules are included with Hyperwire. These modules can be created from the Xtras/Samples folder in the 
Module panel or from the Modules menu and the menu bar. Source code and sample titles that use these 
plug-ins are also included with the product. Complete documentation for the plug-in module system is 
available in the \Hyperwire\Reference\Mdk\mdkguide.html. 

Hyperwire’s Media Player Module
Java 1.x does not include capability for playing video or high-quality sound. JavaSoft plans extensive new 
multimedia capabilities for future versions of Java. If you were a Hyperwire pre-release user, you may have
had a preview of these capabilities using the Media Player module. These module required Intel’s 
implementation of the new Java Media Classes. A new beta version of the Java Media Classes is expected 
to be released soon. Because our software was not compatible with this upcoming version of the Java 
Media Classes, the Media Player module was removed from Hyperwire Version 1.0. Look on the Kinetix 
Web site for details on possible future support of this module and others.

640 x 480 Resolution and Windows 95 
In order to access the OK and Cancel buttons of some Hyperwire dialogs, you must set the Windows 95 
taskbar to auto-hide. 

Installing to a Path Containing Long File Names 
We have seen occasional situations where an installation location path containing a series of long file 
names causes Hyperwire not to find all the Java files on the local drive. 

International / Double-Byte File Support 
Only US English is supported. Hyperwire does not support double-byte characters.

Using Progressive JPEGs
These JPEG files do not display in Hyperwire at author time, either in the Layout View or the Preview 
dialogs. The images display fine at runtime, whether running locally or when deploying your title on the 
Web.

Transitions
You will find that performance for transitions varies depending on the viewer where you run your title. In 
general Java 1.x graphics performance is not yet up to doing complex transitions on large images. You may 
find that performance of transitions on slower machines is unacceptable, unless the image size is 100 x 100,
or smaller.

When running Hyperwire-produced applets under Netscape 3x, you will find that the Shrink and Stretch 
transitions cause some pixels in the image to be drawn black.

When running Hyperwire-produced applets which include Transitions under Netscape 3x, memory used to 
perform the transition is not released until the applet closes. Memory releases properly under Internet 
Explorer, and JavaSoft’s Applet Viewer.

Transparent GIF Files and Transitions
If you have GIF files that have bands of transparency crossing the entire image, transitions may not draw 
correctly in Netscape Navigator and JavaSoft’s Applet Viewer. These same images draw correctly in 
Internet Explorer.



Java, Browsers, and Hyperwire
Speed and other performance problems you may encounter often depend on the limitations of Java and 
browser technologies. Performance should become better as the technology improves. 

Rlinst Folder
If you install Hyperwire’s 3D system, you may find that a folder is left behind in your Hyperwire directory. 
The folder contains install information for the Reality Lab 3D Renderer that Hyperwire uses. This folder 
appears if you choose not to install Reality Lab during your Hyperwire install. Normally, the install process
deletes the folder after installation is complete. This folder can be left behind if the install process was not 
able to finish deleting the folder before completing. The folder can be deleted if Hyperwire’s 3D system is 
installed and running properly.

Previewing Whip! Drawing in Hyperwire’s Layout View
Whip! drawings may not be displayed exactly the same in Hyperwire’s Layout view at author time as they 
do at runtime. This happens only when the Whip! module’s “Maintain Aspect Ratio” flag is off, and a 
custom view has been selected as the default view. The drawing is always displayed correctly at runtime.

License Agreement Folder
You may want to remove this folder after you have installed and reviewed the agreement specific to you. 
Before you do so, we suggest you copy the License Agreement specific to your country to your Hyperwire 
Install directory. The License Agreements are also included on your installation disk or on the Web site 
where you downloaded the product.

Image Module’s Default Size
Changes made to the Image Module’s Default Size flag are not applied to subsequent images. If you load 
an image, apply the Default Size option, and then load a different image file, you must reapply the Default 
Size option for it to take effect on the new image.

Z-Ordering for Text Area and Text Field Modules
Although these widgets always draw in front in the Layout view, it is possible to use the Bring to Front and 
Send to Back features in relation to other Text Areas or Text Fields. The z-ordering behavior may vary from
one browser to another.

Sprite Module and Absolute URLs
It is not possible to load images into the Sprite Module using an Absolute URL. Use the Image Module for 
loading files via Absolute URL.

Associated Plug-in Media Is Not Published
If a user creates a plug-in that requires any accompanying media, the media is not published along with the 
class files by Hyperwire.  You must manually copy over any associated media for plug-ins. 

Using JPEGs Files from Photoshop 4.0
JPEG files saved from Photoshop 4.0 with thumbnail information do not display in JavaSoft’s Applet 
Viewer. Error messages are displayed in your Java Console when loading applets that reference these files. 
These same files display without error in Navigator, Internet Explorer, and in Hyperwire.

Trident-9440-Based Video Cards
The Applet Viewer fails if you use a Trident-9440-based video card in 16- or 24-bit modes. Use 8-bit mode,
or use another browser instead of Applet Viewer.

Loading Image Media
JavaSoft's Applet Viewer will always load images synchronously, no matter what you specify as a property 
for modules with images. Netscape Navigator and Internet Explorer will load images synchronously or 
asynchronously, as specified in the Property dialogs for modules with images.



Error Messages After Closing Applet Viewer
You may get an error message after closing some titles that you’re testing in JavaSoft’s Applet Viewer. 
These errors occur most often after running titles that include sprites and multiple 3D worlds. We believe 
these errors to be a problem specific to the Applet Viewer. Navigator and Internet Explorer close cleanly.

AU Audio Will Work in Applets, Not Applications
AU Audio doesn't work in applications. This is a limitation of Java.

Running Titles Containing Whip Under Windows NT 4.0
Both Applets and Applications which are executed using JavaSoft's Applet Viewer and Java Interpreter do 
not close down properly in 256 color mode under Windows NT 4.0. In some cases a long list of error 
messages are posted to the console when the title closes. In other cases there are no error messages posted 
but the process doesn't close down properly. There are several work-arounds for this problem. First, you 
can run the title in one of the High Color modes. Secondly, you can use Microsoft's Applet Viewer or Java 
Interpreter to view the title.

Netscape Navigator 2.x
Hyperwire applets are not supported in Netscape Navigator 2.x. Although most applets run in this 
environment, Kinetix has not performed extensive testing of applets in Navigator 2.x. 

Any title that includes 3D and Whip modules will not run in Netscape 2.x.

The Hyperwire installation program has an option to search for the existence of Netscape Navigator on 
your system.  This install option will ignore installed versions of Netscape that are previous to 3.0.

Netscape and Hyperwire’s Java Runtime Classes
If you are viewing a Hyperwire title from a server using Netscape 3.0 or better, a published .zip file for that 
title exists on the server, and you have Hyperwire’s Java Runtime Classes installed on your local system, 
Netscape Navigator will use the .zip file from the server instead of the runtime classes existing on your 
local system.

Horizontal Scrollbar Does Not Draw in Netscape Navigator
The horizontal scrollbar for the Text Area module does not appear when running a title under Netscape 
Navigator.  The scrollbar does appear correctly while running the title in the Applet Viewer and Internet 
Explorer.

Java Applet Security Exceptions
Java applets which contain media sometimes do not start when downloaded through a firewall using 
Netscape Navigator. You might see an error message like the following:

# Applet exception: security violation: security.socket.connect: www.hyperwire.com-
>www.hyperwire.com

To learn more about this issue and workarounds for it, see the document on Java applet security at:

http://home.netscape.com/newsref/std/java_security_faq.html

The most practical  workaround to this problem is to make sure users of your titles connect to the HTML 
document containing your applet by IP address rather than the domain name. For example:

http://204.254.64.145/test/apps/mytest.html

rather than,

http:/www.hyperwire.com/test/apps/mytest.html



Note that you have to connect directly to the HTML document by IP address. Connecting to the site by IP 
then navigating to the applet by other means won't work.

This issue is not a problem when using Internet Explorer.

Previously Browsed Title Crashes Netscape Navigator
Often, if you view a Hyperwire title using Netscape Navigator, move onto another title, then back up to the 
previously viewed title, Netscape will crash. We’re working with Netscape to find a solution to this 
problem.

Netscape Communicator Beta 
We have performed some testing with a beta version of Netscape Communicator. We found that it ignores 
Hyperwire applets when the HTML code includes an OBJECT tag before the APPLET tag. Unlike previous
versions of Netscape Navigator, Communicator now recognizes the <OBJECT> tag. The code Hyperwire 
publishes has the OBJECT tag before the APPLET tag. Communicator tries to read the OBJECT tag, 
doesn't understand the CAB entries, so ignores it but doesn't read the subsequent APPLET tag. Hyperwire 
generates the OBJECT tag when you publish CAB files.

If you move the OBJECT block below the APPLET block, it seems to work correctly. 

Compile Error, “Invalid Character”
If you’re using Microsoft’s Java compiler with Hyperwire, you may find that it has intermittent problems 
compiling Java code with long strings. You can work around this problem by using JavaSoft’s compiler 
instead. This problem does not occur when using the JavaSoft or Symantec Java compilers.

Problems with Java Applets and Frames
You will probably run into problems if you try to run two or more separate Java applets in separate frames 
under Internet Explorer. This error condition only occurs when downloading the applets from the Web; no 
error occurs if you run applets locally. An error message may be posted to your javalog.txt file or Internet 
Explorer may crash. This problem does not occur when using Netscape Navigator.

Internet Explorer Will Not Show 3D From a Remote Location
If you have 3D files as part of your Hyperwire title and those files reside on a non-local drive, such as on a 
network, the files will not appear if you are running Internet Explorer. This is not a problem when running 
titles from the Web. 

.CAB Files Will Not Include 3D and Whip Media

.CAB files used with Internet Explorer will contain a title’s class files and media files handled by native 
Java such as image and audio files.  3D geometry/world files and Whip .DWF files are not contained in a 
CAB file and need to reside separately in the same folder as the CAB file.

Loading Large Applets in Internet Explorer
From time to time we have found problems loading large applets into Internet Explorer or Microsoft's 
Applet Viewer. For example, we’ve seen this problem when running Hyperwire’s Introduction title in 
Microsoft’s Applet Viewer. In all cases we were able to get these applets to load after turning off 
Microsoft's JIT. This can be done through the Options dialog in Internet Explorer. We are working with 
Microsoft to resolve this problem.

Using Microsoft’s Java SDK
Hyperwire installs JavaSoft's version 1.02 compiler and runtime class libraries. The Java compiler is 
invoked whenever you "Run" a Hyperwire title. Switching to Microsoft's Java compiler and applet viewer 
can dramatically improve performance when running titles in Hyperwire. Microsoft's Java SDK can be 
downloaded free from www.microsoft.com/java.

Once you've installed Microsoft's Java SDK, you can use Hyperwire's Preference dialog to select their Java 
compiler and viewers. Hyperwire does not automatically recognize Microsoft's Java SDK, so you must 



select it yourself using the Java compiler file browser. For example, if you install Microsoft's Java SDK to 
the default directory, you can select their compiler from C:\SDK-Java\BIN\jvc.exe.

If you encounter compiler errors when running Hyperwire titles, you may have to add an argument to the 
command string so that the compiler can locate the Hyperwire Java Class files. For the default installation 
of Hyperwire, this is:

  /cp c:\hyperwire\classes;c:\hyperwire\java\lib\classes.zip

Completing the example above would give you the entire command line:

  C:\SDK-Java\BIN\jvc.exe /cp 
  c:\hyperwire\classes;c:\hyperwire\java\lib\classes.zip

You can select Microsoft's applet viewer from C:\SDK-Java\BIN\appletviewer.exe. You can select 
Microsoft's Java interpreter for viewing Java applications from C:\SDK-Java\BIN\WJView.exe

Using Symantec Cafe
Hyperwire installs JavaSoft's version 1.02 compiler and runtime class libraries. The Java compiler is 
invoked whenever you "Run" a Hyperwire Title. Switching to the Symantec Cafe Java compiler can 
dramatically improve performance when running titles in Hyperwire. Using the Symantec JIT can 
dramatically improve runtime performance of Hyperwire titles. 

You may have to specify the classpath manually in the Command in order to use Symantec Cafe. For the 
default installation of Hyperwire, this is:

  -classpath c:\hyperwire\classes;c:\hyperwire\java\lib\classes.zip 

An example of a full command line is:

  C:\Cafe\Bin\sj.exe -classpath 
  c:\hyperwire\classes;c:\hyperwire\java\lib\classes.zip    

Hyperwire is not compatible with Cafe 1.0.

Loading 3D Titles with Long File Paths
If you load a 3D world from a file path that has more than 80 total characters, Hyperwire displays a "Can't 
Load File" error message.

3D View or Window Does Not Use Transparency
The 3D View or Window does not use the transparency in a background GIF. The transparent color is 
displayed in the preview window (on the background property sheet), but not in the Layout or at runtime.

Some Biped Files Do Not Display Correctly
3D Studio MAX biped files that contain skin are not displayed correctly within Hyperwire. This happens 
when the biped file is loaded into Hyperwire via VRML 1.0 or VRBL.

Use the UVW Map Modifier In 3D Studio MAX
Use UVW modifiers in 3D Studio MAX to apply tiled texture maps when using .3DS files to export to 
Hyperwire. If you set up your tiling in the Material Editor, the texture does not tile when viewed in 
Hyperwire.

3D File Will Not Load Using Network Neighborhood
When loading a 3D title over the Network Neighborhood, the title will load, but the 3D file will not. A 
“Can’t Load File” message appears.



Copyright (C) Kinetix, a division of Autodesk, Inc. 1997. 3D Studio MAX, BIPED, Hyperwire, Kinetix, 
and Whip! are trademarks, and AutoCAD is a registered trademark of Autodesk, Inc. All other brand names,
product names, or trademarks belong to their respective holders. 

[End]


